第七章 立體留言板-- (FLASH+ASP)
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7-1. 本章目的：

· 留言板是網路上最常見的訊息交流功能，一般都是採用ASP、PHP、CGI等程式來開發，如果可以將之與Flash結合，就能做出兼具使用與美觀效果的留言版了。

· 本章的目的就是結合Flash與ASP技術做出具有3D效果的網路留言板，使用者不但可以留言，還能夠針對留言做出回答，是個具有討論區功能的留言板。
· 但是本範例是在Flash 5 上來建立完成的，這是因為有一行指令eval("list" add i add ":name")，在FlashMX上，系統無法辨認所致
7-2. 在Swift 3D上建立場景元件

(1). 建立書本元件

(A). 開啟Swift 3D
(B). 匯入3DS模組

· File→New From 3DS

[image: image2.png]Edit Yiew Animation Setup





02.tif
· 選擇檔案→OLDBOOK.3DS  (在隨書附錄光碟中可以找到)
· 按下→Import
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(C). 調整書本物件輸出的角度

· 將Camera移到適當的位置
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(D). 匯出成FLASH檔

	[image: image1.png]


[image: image100.png]


[image: image101.png]2



[image: image5.png]Eile ¥iew Animation Window Help
Soane St | Extuson Eator | Lathe EdtrPreview and Export Edtr

Output Options Render Preview

Vector Raster

Gensrats Selected Frames

L3 L KA T T

Target File Type






05.tif
(a). 先點選→Preview and Export Editor

(b). Output Options→Raster

(c). 再點選→Generate Selected Frames
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(d). 完成後選擇輸出檔案→Export Selected Frames

· 檔案名稱→book.swf
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(2). 建立場景桌子的木板元件

(A). 開啟Swift 3D
(B). 開啟新檔

· File→New
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(C). 建立一個板

· 點選工具列上的四方形圖示
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· 點選四方形方塊

· 選擇縮放比率：

· Height→0.050

· Width→2.000

· 結果如下：
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(D). 將物件轉到所要的角度
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(E). 加入材質

· 點選下方的材質面板

· Wood→ER Raster – Petrified

· 按下左鍵不放拖曳到物件上
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(F). 匯出成FLASH檔

(a). 點選→Preview and Export Editor

(b). Output Options→Raster

(c). 再點選→Generate Selected Frames
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(d). 完成後選擇輸出檔案→Export Selected Frames
· 檔案名稱→wood
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7-3. 在FlashMX建立「顯示留言」及「顯示回復留言」的影片片段

(1). 目的：此處動畫乃是當使用者點選書本物件後，被點選的書本將會移動到螢幕中央以便顯示留言內容

(2). 建立「顯示留言」影片片段
(A). 新增元件

· 插入→新增元件
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· 名稱→listbar

· 行為指令→影片片段 
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(B). 匯入OLDBOOK.SWF

· 檔案→匯入
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· 選擇→OLDBOOK.SWF
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(C). 插入關鍵影格

· 在第1、10、20格插入關鍵影格

· 將第10格的影像移到右邊
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(D). 建立補間動畫

· 在二個關鍵影格中按右鍵→建立移動補間動畫
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(E). 書本右移動畫，結果如下所示
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(F). 書本左移動畫，方法同上
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(3). 加入文字
(A). 建立文字圖層

· 加入文字：姓名、日期/時間、Email
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(B). 讓文字跟隨書本移動
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(4). 加入動態文字及按鈕

(A). 加入動態文字，結果如下
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(5). 設定動態文字變數

(A). 設定姓名的動態文字欄位的變數名稱

· 點選「姓名動態文字欄位」

· 屬性→輸入變數名稱：name
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(B). 設定日期/時間的動態文字欄位的變數名稱

· 點選「日期/時間動態文字欄位」

· 輸入變數名稱：

· 日期變數→日期
· 時間變數→時間
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(C). 設定Email的動態文字欄位的變數名稱
· 點選「Email的動態文字欄位」

· 屬性→輸入變數名稱：email
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(D). 設定留言內容的動態文字欄位的變數名稱

· 點選「留言內容的動態文字欄位」

· 屬性→輸入變數名稱：message
	[image: image35.png]



35.tif
[image: image36.png]][ [o B 8t nessaee

B




36.tif



(E). 設定編號的動態文字欄位的變數名稱

· 點選「編號的動態文字欄位」

· 屬性→輸入變數名稱：id
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(F). 設定序號的動態文字欄位的變數名稱

· 點選「序號的動態文字欄位」

· 屬性→輸入變數名稱：num
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(6). 在按鈕上加入action
(A). 直接點選場景中的「回覆按鈕」
· 按右鍵選擇→動作
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	on (release) {


for (i == 1; i<=Number(/:pagesize); i++) {



setProperty(eval("/list" add i), _visible, false);



setProperty(eval("/ans" add i), _visible, false);


}

/:ask = 2;

/:idno = Number(id);

tellTarget ("/") {



gotoAndPlay("submit", "submit");


}

}

	· 因為要切換到「回覆畫面」場景，所以要把之前所顯示的書本留言與回覆留言，都暫時隱藏起來
· /:ask = 1為進入新增留言狀態
· /:ask = 2為進入回覆留言狀態
· idno所要回覆的留言編號
· 回到主場景，然後進入sumit場景


(B). 點選「向上捲動的按鈕」
· 按右鍵選擇→動作

[image: image42.png]on (elease) {
‘message scroll = Nomaber (messagessceoll-1;

}




42.tif
	on (release) {

message.scroll = Number (message.scroll)-1;

}

	· message是顯示留言內容的文字欄位變數
· 將message欄位的內容做向上捲動的指令就是message.scroll = Number (message.scroll)-1


(C). 點選「向下捲動的按鈕」
· 按右鍵選擇→動作
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	on (release) {


message.scroll = Number (message.scroll)+1;

}
	· message是顯示留言內容的文字欄位變數
· 將message欄位的內容做向下捲動的指令就是message.scroll = Number (message.scroll+1


(7). 加入一個「觸碰式移動的按鈕」
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(A). 將顏色設為透明

· 顏色→Alpha：0%
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(B). 在物件上加上action
(a). 點選「按鈕圖層」的第一影格

· 再點選「透明的按鈕」
· 按右鍵選擇→動作：加上action

	on (press) {

gotoAndPlay(2);

}

	· 前往第二影格並播放
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(b). 點選按鈕圖層的第十影格

· 再點選透明的按鈕

· 按右鍵選擇→動作：加上action

	on (press) {

gotoAndPlay(10);

}

	· 前往第10影格並播放
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(C). 在影格加上action

(a). 點選「按鈕圖層」的第1影格

· 按右鍵選擇→動作：加上action

	stop()
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(b). 點選按鈕圖層的第十影格

· 按右鍵選擇→動作：加上action

	stop()
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建立「顯示回覆留言」

(D). 新增元件
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· 名稱：→ answer

· 行為指令→影片片段
(E). 「回覆留言」製作方法跟之前顯示留言的方法都一樣，只是多加「回應」兩個字在右上角
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7-4. 建立「資料下載中…」的動畫

(1). 新增元件

· 插入→新增元件

· 名稱→下載中

· 行為指令→影片片段
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(A). 建立柱狀的漸變動畫
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(2). 將下載中的影片片段拖曳到場景中

(A). 將第1格到第4格設定為關鍵影格

(B). 將影片片段放在第1格到第3格
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(3). 在關鍵影格上加上action

(A). 第一個關建影格

	 /:ok = 0;

/:pageNo = 1;

loadVariablesNum("msg_paging.ASP", 0, "POST");

	· ok=0表示asp資料仍未完全讀入

· pageNo=1將從第一頁顯示

· 使用loadVariablesNum來接收msg_paging.asp檔案所傳來的值


(B). 第二個關建影格

	if (/:ok==100) {


gotoAndPlay(4);

}

	· ok=0表示asp資料已經完全讀完，於是前往第4影格並且播放




(C). 第三個關建影格

	gotoAndPlay(2);

	· 否則表示仍未完全讀完，那麼跳回第2格重新接收變數




(D). 第4個關建影格

	stop();

/:ok = 0;

	· 完全讀完後，將ok值設定為0，因為下面還會在針對ok值做判別




(E). 結果如下
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進行立體留言板各物件的版面配置

(4). 拖曳「發表留言」及「回覆留言」影片片段到主場景

新增一個圖層

· 名稱→留言板

· 設定第4格為關鍵影格
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(A). 拖曳兩個影片片段

· 點選第4關鍵影格

· 先拖曳「發表留言」(listbar)

· 再拖曳「回覆留言」(answer)

(B). 結果如下所示
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(5). 匯入用swift3d所完成的木板桌子

(A). 新增一個圖層

· 名稱→桌子

· 設定第4格為關鍵影格
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(B). 匯入swift3d檔案

(a). 點選第4格關鍵影格
(b). 檔案→匯入
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(c). 檔案名稱→wood
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(d). 結果如下所示
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(6). 加入「跳頁按鈕」及「新增留言按鈕」
(A). 新增一個圖層

· 名稱→按鈕

· 設定第4格為關鍵影格
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(B). 加入「按鈕」及「動態文字」如下圖
[image: image65.png]
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(C). 加入ation及設定動態文字的變數
(a). 點選「第一頁按鈕」

· 設定action

[image: image66.png]on (elease)
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	on (release) {


pageNo = 1;


loadVariablesNum("msg_paging.ASP", 0, "POST");


gotoAndPlay(5);

}
	· 使用loadVariablesNum來接收msg_paging.asp檔案所傳來的值
· 並且設定顯示第1頁的資料
· 前往第5影格判別是否已經讀取完ASP檔案，如果已經讀完則跳回第4影格顯示新的內容


(b). 設定「上一頁的按鈕」的action
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	on (release) {


if (pageNo>1) {



pageNo = Number (pageNo)-1;



loadVariablesNum("msg_paging.ASP", 0, "POST");



gotoAndPlay(5);


}

}

	· 使用loadVariablesNum來接收msg_paging.asp檔案所傳來的值
· 並且設定顯示的頁數為目前頁數(pageNo)-1
· 前往第5影格判別是否已經讀取完ASP檔案，如果已經讀完則跳回第4影格顯示新的內容


(D). 設定目前頁數的動態文字欄位的變數名稱

· 點選「目前頁數的動態文字欄位」

· 屬性→輸入變數名稱：pageNo
[image: image68.png]
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(E). 設定總頁數的動態文字欄位的變數名稱

· 點選「總頁數的動態文字欄位」

· 屬性→輸入變數名稱：pageCount
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(a). 設定「下一頁按鈕」的action
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	on (release) {


if (pageNo<Number(pagecount)) {



pageNo = Number (pageNo)+1;


if (pageNo==Number(pagecount)) {




for (i=1; i<=Number(countno); i++) {





removeMovieClip(eval("/list" add i));





removeMovieClip(eval("/ans" add i));




}



}



loadVariablesNum("msg_paging.ASP", 0, "POST");



gotoAndPlay(5);


}

}
	· 使用loadVariablesNum來接收msg_paging.asp檔案所傳來的值
· 並且設定顯示的頁數為目前頁數(pageNo)+1
· 如果目頁數已經是最後一頁了，那麼將畫面上的所有「顯示留言」與「回覆留言」影片都刪除


(b). 設定「最後頁的按鈕」及action
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	on (release) {


pageNo = Number(pagecount);

for (i=1; i<=Number(countno); i++) {



removeMovieClip(eval("/list" add i));



removeMovieClip(eval("/ans" add i));


}

loadVariablesNum("msg_paging.ASP", 0, "POST");


gotoAndPlay(5);

}
	· 使用loadVariablesNum來接收msg_paging.asp檔案所傳來的值
· 並且設定顯示的頁數最後頁頁數(pagecount)
· 將畫面上的所有「顯示留言」與「回覆留言」影片都刪除
· 前往第5影格判別是否已經讀取完ASP檔案，如果已經讀完則跳回第4影格顯示新的內容


(c). 設定「新增留言按鈕」及action
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	on (release) {

for (i=1; i<=Number(pagesize); i++) {



removeMovieClip(eval("/list" add i));



removeMovieClip(eval("/ans" add i));


}

/:ask = 1;

gotoAndPlay("submit", "submit");

}
	· 因為要切換到「新增留言」場景，所以要把之前所顯示的書本留言與回覆留言，都刪除

· /:ask = 1為進入新增留言狀態
· /:ask = 2為進入回覆留言狀態
· 回到主場景，然後進入sumit場景


(7). 設定一次顯示在畫面上所有的留言及其action

(A). 先新增一個圖層

· 名稱→筆數

· 設定第4、5、6格為關鍵影格
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(B). 在關鍵影格中加入影片片段及action
(a). 第4關鍵影格的action
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	for (i=1; i<=Number(countNo); i++) {


if (eval("rpy" add i) != 1) {



duplicateMovieClip("list", "list" add i, i);



setProperty(eval("list" add i), _visible, true);



setProperty(eval("list" add i), _x, 450-30*(i-1));



setProperty(eval("list" add i), _y, 70+20*(i-1));



eval("list" add i add ":name") = eval("name" add i);



eval("/list" add i add ":email") = eval('email' add i);



eval("/list" add i add ":日期") = eval('日期' add i);



eval("list" add i add ":時間") = eval('時間' add i);



eval("list" add i add ":message") = eval('message' add i);



eval("list" add i add ":id") = eval('id' add i);



eval("list" add i add ":num") = i;



idno1 = eval("/list" add i add ":id");

} else if (eval("rpy" add i) == 1) {



duplicateMovieClip("ans", "ans" add i, i);



setProperty(eval("ans" add i), _visible, true);



setProperty(eval("ans" add i), _x, 450-30*(i-1));



setProperty(eval("ans" add i), _y, 70+20*(i-1));



eval("ans" add i add ":name") = eval("name" add i);



eval("/ans" add i add ":email") = eval('email' add i);



eval("/ans" add i add ":日期") = eval('日期' add i);



eval("/ans" add i add ":時間") = eval('時間' add i);



eval("/ans" add i add ":message") = eval('message' add i);



eval("list" add i add ":num") = i;


}

}
	· 如果當eval("rpy" add i)不等於1時，表示要放置「顯示留言影片」(listbar)
· 在此要設定「顯示留言書本影片」的(x,y)位置

· 及設定每個書本上的文字欄位等於由ASP檔案接收過來的變數值

· 如果當eval("rpy" add i)等於1時，表示要放置「回覆留言影片」(answer)
· 同樣地，要設定「回覆留言書本影片」的(x,y)位置

· 並且設定每個書本上的文字欄位等於由ASP檔案接收過來的變數值




(b). 第5關鍵影格的action及影片片段
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	if (/:ok == 100) {


gotoAndStop(4);

}
	· ok=100表示asp資料已經完全讀完，於是前往第4影格並且播放
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(c). 設定第6關鍵影格的action
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	gotoAndPlay(5);
	· 否則表示仍未完全讀完，那麼跳回第5格重新接收變數




7-5. 建立回覆留言及發表留言的表單

(1). 新增場景及修改場景名稱

(A). 插入→場景
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(B). 修改場景名稱

· 修改→場景
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· 設定場景名稱→submit
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(2). 設定「回覆留言」及「發表留言」的表單配置

(A). 新增欄位名稱如下圖
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(B). 新增文字欄位及設定變數名稱
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(a). 設定姓名文字欄位的變數名稱

· 點選「姓名文字欄位」

· 屬性→輸入變數名稱：name
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(b). 設定Email文字欄位的變數名稱

· 點選「Email文字欄位」

· 屬性→輸入變數名稱：email
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(c). 設定留言文字欄位的變數名稱

· 點選「留言入文字欄位」

· 屬性→輸入變數名稱：message
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(d). 設定「回覆留言編號」文字欄位的變數名稱

· 點選「回覆留言編號的文字欄位」

· 屬性→輸入變數名稱：ID
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(e). 設定「是否回覆」文字欄位的變數名稱

· 點選「是否回覆文字欄位」

· 屬性→輸入變數名稱：rpy
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(3). 設定文字欄位的初始值

· 點選「留言板面」圖層→第1關鍵影格

· 加入action
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	name = "";

email = "";

message = "";
if (/:ask==1) {


ID = number(/:recordcount)+1;


rpy = 0;
} else if (/:ask==2) {


ID = number(/:idno);


rpy = 1;

}

done = 5;

stop();

	· 先設定這些文字欄位的起始值為空字串
· 如果ask==1代表要「新增」留言，於是設定

· 新留言的ID值為目前總筆數為0

· rpy變數為0

· 如果ask==2代表要「回覆」留言，於是設定

· 回覆留言的ID值為目筆數為idno
· rpy變數為1




(4). 建立並設定「重寫」、「離開」、「送出」按鈕的action

(A). 新增圖層→按鈕

· 設定第一格為關鍵影格

· 新增3個按鈕「重寫」、「離開」、「送出」
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(B). 設定「重寫按鈕」的action
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	on (release) {


name = "";


email = "";


message = "";

}
	· 設定這些文字欄位的值為空字串




(C). 設定「離開按鈕」的action
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(D). 設定「送出按鈕」的action
[image: image93.png]



93.tif
	on (release) {


/:ok = 0;


gotoAndPlay(2);

}
	· 設定ok = 0並到第2影格播放




(5). 建立確認訊息的畫面

(A). 配置「確認訊息畫面」如下
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(B). 點選按鈕圖層的第2影格

· 在影格中加入action→stop()
· 並設定「重新輸入按鈕」的action
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	on (release) {


gotoAndPlay("submit");

}
	· 重新回到submit場景




· 設定「確定按鈕」的action
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	on (release) {

if (/:ask==1) {



loadVariablesNum("msg_ask_insert2.ASP", 0, "POST");


} else if (/:ask==2) {



loadVariablesNum("msg_rply_insert2.ASP ", 0, "POST");


}


gotoAndPlay("show", 1);

}
	· 如果ask==1代表要「新增」留言，於是執行ASP檔案msg_ask_insert2.ASP 來新增記錄到資料庫
· 如果ask==2代表要「回覆」留言，於是執行ASP檔案msg_rply_insert2.ASP 來新增回覆記錄到資料庫




(6). 建立「錯誤訊息畫面」

(A). 建立「錯誤訊息畫面」如下
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(B). 點選「按鈕圖層」的第3影格

· 在影格中加入action→stop()
(C). 設定「重新輸入按鈕」的action
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	on (release) {


gotoAndPlay("submit");

}
	· 重新回到submit場景




(D). 設定「確定儲存按鈕」的action
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	on (release) {


gotoAndPlay("show", 1);

}
	· 重新回到主場景第1影格




(7). 使用Dreamweaver MX 編輯「分頁顯示留言」ASP檔案

(A). 檔案名稱：msg_paging.ASP
(B). 功用：這是讀取留言板資料庫guestbook.mdb，並且分頁顯示記錄的檔案
	<%

    Sub ShowPage(objRS, PageNo)

        '讀取資料表的欄位名稱以做為表格的標題
        objRS.AbsolutePage = PageNo 

        For I = 1 To objRS.PageSize

            For J = 0 To objRS.Fields.Count - 1

                data=data & "&" & objRS.Fields(J).Name & i & "=" & objRS.Fields(j).Value

            Next

            objRS.MoveNext

            m=i

            If objRS.EOF Then Exit For

        Next    

            Response.Write Data & "&pageNo=" & pageNo & "&pageCount=" & objRS.PageCount & "&ok=" & "100" & "&pagesize=" & objRS.pagesize & "&countNo=" & m & "&recordCount=" & objRS.recordcount & "&countNo1=" & i

    End Sub

%>

<HTML>

  <BODY>

    <!-- #include file="ADOFunctions.asp" -->

    <%  

        '讀取資料表的所有記錄

    strSQL = "select * from guestbook order by ID Desc, rpy Asc, 日期 Asc, 時間 Asc"    

    
Dim objRS


    Set objRS = GetSQLRecordset(strSQL, "guestbook.mdb", "guestbook") 

        '設定分頁大小
        objRS.PageSize = 5

        PageNo = Request("PageNO") 

        If PageNo <> "" Then 

           ShowPage objRS, PageNo



else

           ShowPage objRS, 1






        End If

    %>

  </BODY>                                                                                 

</HTML>

  </BODY>                                                                                 

</HTML>




(8). 使用Dreamweaver MX 編輯「儲存新增留言」ASP檔案

(A). 檔案名稱：msg_ask_insert2.ASP
(B). 功用：這是將新的留言儲存到資料庫guestbook.mdb，的ASP檔案
	    <!-- #include file="ADOFunctions.asp" -->  

    <%  

    Dim strSQL,name,email,message,num

    Dim objRS

    name=request("name")

    email=request("email")

    message=request("message")


ID=request("ID")


if email = Empty then



email="None"


end if

    strSQL = "INSERT INTO guestbook (ID,name,email,message,日期,時間) VALUES ('" & ID & "','" & name & "','" & email & "','" & message & "',date(),time())"    

    Set objRS = GetSQLRecordset(strSQL, "guestbook.mdb", "guestbook") 

    response.write "&done=2"

    %>


(9). 使用Dreamweaver MX 編輯「儲存回覆留言」ASP檔案

(A). 檔案名稱：msg_rply_insert2.ASP
(B). 功用：這是將回覆留言儲存到資料庫guestbook.mdb，的ASP檔案
	    <!-- #include file="ADOFunctions.asp" -->  

    <%  

    Dim strSQL,name,email,message,num,rpy,ID

    Dim objRS

    name=request("name")

    email=request("email")

    message=request("message")


rpy=request("rpy")


ID=request("ID")


if email = Empty then



email="None"


end if

    strSQL = "INSERT INTO guestbook (ID,rpy,name,email,message,日期,時間) VALUES ('" & ID & "','" & rpy & "','" & name & "','" & email & "','" & message & "',date(),time())"    

    Set objRS = GetSQLRecordset(strSQL, "guestbook.mdb", "guestbook") 

    response.write "&done=2"

    %>























































